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Introduction to Illustrator 10, UPP 502, Spring 2007 
 
Illustrator is the vector companion to Photoshop. Use it as a drawing 
tool and as a layout tool, especially for laying out posters and 
presentations. Think: Powerpoint with a LOT more functionality. 
 
We are going to make an 8.5 X 11" illustration of a 
redevelopment proposal for downtown Beautiful Oaks. This can 
be included in a supporting document or distributed independently.  
There are three files you will use in the exercise: downtown.tif,  
beautifuloaks20070307.jpg, and oakleafskunk.gif 
 
1. Sketch out your boards by hand. 
Making a sketch of what you want to design the entire process easier. 
Use a pencil and piece of paper. Try it, you'll enjoy the experience. 
Consider: final print size, where it's going to be published. 
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2. Illustrator Work Area: 
 

 
 
 
3. How to set up the Artboard Work Area the first time 

a. File menu > New ...  
 
 
 

Imageable area 
(area within inside dotted line) 

Non-Imageable Area  
(margin where printer won't print… 
area between dotted lines) 

Imageable + Non-Imageable = Print Page 

Artboard (inside solid black line) 

Scratch  
Area 
(outside 
solid 
black 
line) 
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4. How modify the Artboard Work Area after establishing it: 
 

a. File menu > Document Setup...  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5. How to set up the Print Setup Work Area: 

a. File menu > Print Setup > select the printer you will 
ultimately use. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
>> Activity: Temporarily set the paper size for printing at something 
smaller than "Letter."   Select the Page Tool  from the Tools 
Palette.   The Page Tool is located beneath the Hand Tool.  
With the Page Tool selected, click anywhere on the Artboard.  Note 
that the lower left corner of the printer page aligns with the location of 



Introduction to Illustrator, UPP 502, Spring 2007. 14 March 2007 Page 4 
 

your click.  Double left clicking on the Page Tool aligns the printer 
page with the lower left corner of the Artboard.  Double clicking on the 
Hand Tool centers the Artboard in your work area.   
 
Before you proceed with the exercise, go back and reset the Print 
Setup to "Letter."  
 
6. Concept: Palettes. 
 
Pull down the Windows menu.  A list of palettes will appear.  At a 
minimum you should always keep the Tools Palette (sometimes 
called the Tool Bar) and the Layers Palette visible. 
 
The Palettes listed below will be used in the exercise:  

Tool 
Color  
Layers 
Stroke 
Pathfinder 
Align 
Swatches 
Type > Character 
Type > Paragraph 
Appearance 

 
These palettes are pictured in the appendix to this document. 
 
Four items on palette behavior are important to note. (1) You can 
move them around to anywhere on your screen that pleases you.     
(2) Often palettes are clustered.  For example, below you can see that 
the Character and Paragraph Palettes are clustered.  You can create a 
cluster by dragging a palette on top of another palette.  You can 
"decluster" palettes by clicking on the tab of one of the palettes and 
dragging it away. (3) The tab identifying each palette, often have a 
small "toggle" icon located to the left of the palette name.  Clicking on 
this toggle gives you different views of the palette. (4) Each palette 

will have a black triangle in the upper left 
corner.  Clicking in this "twirly" will activate a 
context menu……as you will see, these can be 
quite important. 
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7. Concept: Path, Fill, Stroke. 
You can make all sorts of shapes with various tools. What you are 
creating is called a path.  

A path has two components: fill and stroke. 
Fill has characteristics you can change like color, gradient, opacity, 

effects (feather, inner glow). 
Stroke has characteristics you can change like color, thickness, end 

caps. 
The stroke conforms to the path that you digitize. 
The fill puts color inside the boundaries of the path you digitize. You 

do not have to close a path in order for it to have fill. 
 
 
8. Concept: Working in Layers. 
Keep each type of stuff in its own layer, for example, pictures, text, 
linework. Lock layers not in use. Select a layer to work in it.  You must 
take special care to note what layers are active, what layers are 
unlocked, etc.  Look at Layers Palette. Each layer has its own selection 
color so you can tell which objects go in each layer and whether there 
is an active selection in the layer. 
 
9. Bring in aerial photo. 
File menu > Place ... > 
navigate to downtown.tif 
 
UNcheck LINK 
 
You can link to an image or 
you can place it directly into 
the illustrator file. 
 

Using the Scale Tool  
select the image and resize 
it. Hold the shift key to 
scale proportionately  
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Check out the Layers Palette.  Note that your image now has a layer 
named Layer 1.  Double click on the layer name to get a dialogue box 
you can use to name the layer and give it a selection color.  Name the 
layer "aerialphoto." 
 

 
 
10. Mask the image to show just what you want. 

Using Rectangle Tool,  draw a rectangle over the part of the 
image you want to see. It is selected.  Do not worry if the area you 
selected with the Rectangle Tool is covered by a solid color that you 
cannot see through.  In the two images below (found at bottom of 
Tools Palette), a fill color is selected (on left) or "no color" is selected 
(on right).  You can toggle back and forth by clicking on the small 
squares on the bottom left or bottom right side of this cluster of icons. 
 

                                                  
 

 
Toggle between a fill color and no color 

 
To add the aerial photo to your rectangle selection: Select the aerial 
with Select Tool + Shift.  Now both the rectangle and the aerial photo 
are selected. 
 
To make mask: Object menu > Clipping Mask > Make  
Now these objects are one and you only see your desired part of the 
aerial. 
 
Now would be a good time to save the Illustrator document. 
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11. Trace the aerial to draw roads. 
 
Add a new layer to do this.   Do this by  
 

    (1) clicking on the "twirly" in the 
Layers Palette and select New Layer 
or  
 
 
    (2) by clicking on the second icon 
from the right at the bottom of the 
Layers Palette.  Call the new layer 
"streets". 
 

 
 
Lock the aerial photo layer by clicking in the empty box to the right of 
the "eyeball" associated with that layer. 
 

Zoom in on the aerial photo using the Zoom Tool    (note: you can 
zoom out by holding down the Alt key while using the Zoom Tool; 
using the Cntl key with plus or minus will also zoom in and out, 
respectively). 
 
Make sure the "streets" layer is active.  Using the Pen Tool,  click 
to trace the intersecting roads.  Click on a starting point, then click at 
successive "vertices."  This will outline the edges of the intersecting 
roads.   When you click at a spot, that node is solid and previous 
nodes are shown as hollow.  If you make a mistake, selecting the 
Delete key will eliminate all the solid nodes (and lines connecting 
them) back to the last hollow node.  Go ahead and make a mistake 
and then correct it to see how this works. 
 
When you get back to the point at which you began, note that the pen 
tool will have a small (very small) zero on the bottom right edge of the 
tool.  This signifies that you are over the closing point of your traced 
road.  Click and the trace will close.  This trace is a path.  If your fill 
and stroke colors are set to "no color" you won't see any evidence of 
what you have just done except for the pen trace itself.  So to avoid 
possible frustrations, go back to that fill/stroke icon cluster…. 

   ….select the "patch" with the hollow square, click on it to 
bring it ahead of the other "patch."  Select the small icon on the lower 
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left.  Double click on the hollow "patch" to get the color picker and pick 
a color.  The "stroke" (outline) of the path you have created with your 
trace will now be shown in the color you selected.  Similarly, click on 
the other "patch" to bring it to the front; double click on it to get the 
color selector.  Select a color and now the area with the trace will be 
filled. 
 
Use the Zoom Tool to get a closer look at the trace you made.  Pan 
around with the Hand Tool.  (Neat hint: Regardless of the tool you 
may be using, holding the space bar down will bring up the Hand 
Tool!!) 
 
You can add new nodes by clicking on your trace with the Add Anchor 
Point Tool   (underneath the pen tool, it is a pen tool with a plus 
sign).  Similarly, you can subtract nodes by using the Delete Anchor 
Point Tool   .  To move an anchor point use the Direct Select 
Tool  (looks just like the Select Tool except it is hollow). Click on 
one of the anchor points and drag it to a new location.  This might be 
troublesome if all the anchor points are selected (all filled in).  If that 
happens, click away from the trace outline and try selecting again. 
 
 
12. Now add some buildings. 
 
Add a new layer, call it "buildings"  Make sure to lock the other layers. 

Using the Rectangle Tool  , add a building footprint.  When you 
make a building footprint make sure you establish a stroke weight 
(open the Stroke Palette and choose point size for line width) and 
stroke color and a fill color.  You can make copies of buildings using 
Cntl-C and then paste with Cntl-V commands. 
 
To move, rotate, or change size of buildings, you need to first select a 
building footprint using the Select Tool .  You then can drag 
footprints to new locations.  You also can use the Scale Tool   and 
the Free Transform Tool   to change size and rotate the building 
footprints. 
 
Now you can play with aligning the 
buildings using the Align Palette. 
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If you have, say, three buildings near one another, you can select 
them, then use the buttons on the Align Palette to align, distribute or 
space the building footprints. 
 
For the next step, we'll make a drop shadow. Make sure that only the 
building layer is unlocked so only building footprints are selected. 
Select all the buildings (select using the shift key or click and drag the 
select button creating a selection rectangle across all the buildings).  
 
Make a drop shadow. 
Filter menu > Stylize > Drop Shadow 

 
Use these 
settings exactly 
as shown. 
 
Click the eyeball 
on the aerial 
photo layer to 
make it invisible 
so you can see 
what you have 
done.  Cool, huh? 
 
Save again! 

 
13. We need some trees. 
 
Lock all the layers and then add a new one.  Call it "Trees." 
 
Select "no color" for stroke and some nice tree-
like green color for fill.  Use the Ellipse Tool  
to draw a bunch of overlapping blobs.  Select all.   
 

 
Get the Pathfinder 
Palette….. 
  
… and click on Merge (third button from left 
on bottom row. This will turn all the separate 
blobs into one tree.  Make copies, resize a 

few and place them here and there along the boulevard. 
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Select all the trees.  Make new drop shadows (from Filter menu).  For 
the color selection, use a dark green color.  
 

 
 
 
 
Use the settings 
exactly as 
shown.  Make 
sure you select 
"Create Separate 
Shadows."  This 
allows trees to 
have shadows on 
other trees. 
 
 

 
 
14.  And finally, some green grass. 
 
Lock all the layers and add a new layer called "parkways" 
Use the Pen Tool to sketch in some parkways.  Make it more 
interesting by giving the fill a gradient (you cannot give a stroke a 
gradient in Illustrator 10). 
 
Open up the Swatches Palette…      and the Gradient Palette… 

 
 
 
 
 
 
 

 
 
Look at the fill/stroke cluster of icons again.  Bring fill to the 
front.  The left little icon below the fill/stroke patches is for 
solid fill or stroke; the right little icon is for "no color."  The 
little icon in the middle is for gradients.  Click on that and 

note what happens to the fill patch, to the gradient palette, and, if 
anything is selected on your Artboard, to the selected feature. 
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See that the gradient palette now 
shows little symbols above and 
below the gradient preview 
window…. 
 
 
 

 
As it appears above, the left-most symbol below the gradient preview 
window is for designating the color at the beginning of the gradient.  
The right-most symbol is for the color at the end of the gradient.  The 
symbol on the top of the preview window and in the middle is for 
setting an inflection point.  Slide all of these back and forth to see 
what happens. 
 
For this exercise we would like to get the parkways to have a gradient 
from a medium light green to a medium dark green. 
 
To get the colors you want to use, double click on the fill patch to get 
the color picker and choose a medium light green.  Drag that green to 
the swatch palette.  Then drag the new green swatch over the left-
most symbol beneath the preview window in the gradient palette.  
Repeat this for your medium dark green color but apply it to the right-
most symbol. 
 
Select one of the parkways you created.  Go to the fill/stroke icon 
cluster and click on the small icon in the middle of the grouping 
beneath the fill/stroke patches.  The gradient is applied.  But there is 
more!! 
 
Select the Gradient Tool .  With this tool you can click on a point 
within a selected parkway and drag the cursor.  By doing this you are 
selecting the beginning and end of the gradient as well as the direction 
and length of the gradient. 
 
We have finished drawing on top of the aerial photo. 
 
15. Move the drawings to the right of the aerial photo. 
 
Leave the aerial photo layer locked but unlock all other layers.  Select 
all the layers with drawings, select all, and drag them to the right in a 
location consistent with your pencil drawing at the start of this 
exercise.  Select all unlocked layers in the Layer Palette (shift-click) to 
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make them all active.  Go to Scale Tool and increase the size of your 
drawing a little (remember to hold down the shift key so the scale 
adjustment retains proportions).  Look at your whole Artboard (double 
click the Hand Tool).  Re-position images to make room for (a) your 
"rendering" of Beautiful Oaks, (b) the poster title, and (c) attribution 
text and Village logo.  Time to save your document again. 
 
16. Bring in the colorized Beautiful Oaks line drawing. 

 
Create a new layer called "rendering". Make it active. Lock all other 
layers. 
 
Retrieve BeautifulOaks20070307.jpg by pulling down the File menu 
and choosing Place....  Navigate to where you are storing the file and 
bring it into Illustrator.  Be sure to uncheck "link" as you did with 
downtown.tif at the beginning of the exercise.  Select the rendering 
image and, using the Scale Tool and Select Tool, resize it and 
position the image. 
 
Use the Rectangle Tool to draw a box around the image.  Don't give 
the box a fill but set the stroke width and color.  Use the Eyedropper 
Tool   to steal color from the street fill color you made in Step 11. 
Click on the Eyedropper Tool to make it the cursor, then click on the 
street fill.  This will change the fill patch to the selected color.   You 
then can proceed in one of two ways.   
 

(A) In the fill/stroke icon cluster, in the upper right area 
there is an arrow. (When you hover over it, it says, "Swap 
Fill and Stroke".) Clicking on it switches the fill and stroke 

colors.  Select the "no color" for the fill patch and bring the stroke 
patch to the front by clicking on it.  Assuming the rectangle is still 
selected, this should change the outline color of your rectangle around 
the rendering to the desired color.  
 
-OR- (B) After the fill patch is the selected color, drag it over to the 
Swatches Palette.  Go back to the fill/stroke icon cluster and click on 
the stroke patch.  Go back to the Swatches Palette and click on that 
new swatch.  Now the stroke patch and the stroke of your rectangle (if 
it is still selected) will be displayed in the desired color. 
 
Group the rectangle and the rendering by selecting both (click, then 
shift-click).  Pull down the Object menu and choose "Group." 
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17. Add a title. 
 
Lock down all the layers and make a new layer.  Call it "Title box".  
Use the Rectangle Tool to make a box at the top of the poster.  Make 
its stroke black and 0.25 pt. thick. Make its fill the same color you 
used for the trees.  To do this, use the Eyedropper Tool to select the 
tree color from the drawing.  Next drag the fill patch color to the 
Swatches Palette.  Select the title box with the Select Tool and the 
color will fill.   
 
Select the Text Tool  and open the Character Palette. 
(Type>Character) 

 
Set the beginning of the text with 
the Text Tool.  Use Verdana, 28 
point, bold.  Make your fill patch 
white.  Type text as shown below.  
 
Use the options in the Character 
Palette to "squeeze" the text into 
the space.   
 
 

With the Select Tool, position the text within the box.  See below for 
a suggested outcome. 

 
 
18. Add additional text. 
 
Lock down all the layers and make a new 
layer.  Call it "More Text".  We're going to add 
text into two text boxes that describe (1) why 
the poster was made and (2) who prepared the 
poster, including the date it was made.  Lock 
all the other layers.  Choose the Text Tool but 
instead of using it only to set the beginning for your text, click where 
you want to begin and drag it to create a text box.  Now as you type, 
the text will flow.  Using the Paragraph Palette, you can set 
alignment rules ("justify full lines" in the multi-line example here).  
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19. Add a logo. 

 
Locking all the other layers, add a 
new layer called "Logo" and add the 
logo (File menu>Places…). Navigate 
to oakleafskunk.gif.  Make sure 
the logo draws behind the "More 
Text" layer by clicking on relevant 
layer and dragging it into the correct 
order in the Layers Palette. In the 
Layers Palette, the first layer to 
draw is always on the bottom.  This 
means that you need to rearrange 
the order so that the "Logo" layer is 
below the "More Text" layer. 
 
20. And finally…. 

 
Add another new layer.  Call it "Bubble Numbers".  Remember to lock 
the other layers.  Using Ellipse Tool,   add an ellipse or circle.  
Set the stroke to "no color" but make the fill color a light green – 
perhaps, repeating one of the colors you used for trees or parkways.  
Soften the edges of the ellipse by feathering: 
Effect menu > Stylize > Feather ... 
Use .25 to feather.  
 
 
Add a number using Text Tool, make numbers 
white with a stroke color the same as the title. 
 
Select both the ellipse and the number and group them into one 
selection.  Copy and paste the grouped object to get two more 
ellipses.  With the Select Tool, move them so that each of the three 
main images has a "bubble number."  Edit the numbers by clicking on 
them with the Text Tool, backspacing and typing in the appropriate 
number (1, 2 or 3). 
 
Save it one last time. 
 
Congratulations! 
 
This tutorial was produced by the Great Cities Urban Data Visualization Lab to 
support the Spring 2007 UPP 502 Planning Skills course in the College of Urban 
Planning and Public Affairs, University of Illinois at Chicago. 

Example of number in a 
feathered ellipse. 
 




